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Contents:

• Get to Know S32K118 EVB

• Out of the Box Setup

• Introduction to OpenSDA

• Creating a new S32DS project for S32K118:
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− Create a project

− Create a project from SDK example

• S32DS Debug basics

• Create a P&E debug configuration
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External Power Supply (5-12V)

CAN Communication Bus

RGB LED

S32K118 MCU

LIN Communication Bus

OpenSDA USB
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OpenSDA MCU

OpenSDA JTAG

Potentiometer

User Buttons

Get to know S32K118-EVB

J2 Header

J1 Header

J3 Header

J4 Header

SBC UJA1169

Touch electrodes

J14 SWD connector.

Transceiver TJA1027T
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S32K118 EVB Features:

• Supports 64LQFP and 48LQFP packages

• Small form factor size 4.5” x 2.3”

• Arduino™ UNO footprint-compatible with expansion “shield” support

• Integrated open-standard serial and debug adapter (OpenSDA) with 

support for several industry-standard debug interfaces

• Easy access to the MCU I/O header pins for prototyping

• On-chip connectivity for CAN, LIN, UART/SCI. 

• SBC UJA1169 and LIN phy TJA1027

• Potentiometer for precise voltage and analog measurement

• RGB LED

• Two push-button switches (SW2 and SW3) and two touch electrodes

• Flexible power supply options

• microUSB

• external 12V power supply
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Header/Pinout Mapping for S32K118

Arduino compatible pins

NXP pins *0ohm resistor is not connected

J3

J4

J2

J1

PIN PORT FUNCTION J3 PIN PORT FUNCTION

J3-02 PTB0 GPIO J3-01 - VBAT

J3-04 PTB1 GPIO J3-03 - VDD_PERH

J3-06 PTB6 GPIO J3-05 PTA5 RESET

J3-08 PTB7 GPIO J3-07 - 3.3V

J3-10 PTE4 GPIO J3-09 - 5V

J3-12 PTE5 GPIO J3-11 - GND

J3-14 PTA11 GPIO J3-13 - GND

J3-16 PTB12 GPIO J3-15 - VBAT

PIN PORT FUNCTION J4 PIN PORT FUNCTION

J4-02 PTC6 GPIO J4-01 PTA6 ADC0_SE2

J4-04 PTC7 GPIO J4-03 PTC0 ADC0_SE8

J4-06 PTC8 GPIO J4-05 PTC1 ADC0_SE9

J4-08 PTC9 GPIO J4-07 PTC14 ADC0_SE12

J4-10 PTD4 GPIO J4-09 PTC15 ADC0_SE13

J4-12 PTD15 GPIO J4-11 PTC16 ADC0_SE14

J4-14 PTD16 GPIO J4-13 PTC17 ADC0_SE15

J4-16 PTE8 GPIO J4-15 PTB13 GPIO

PIN PORT FUNCTION J1 PIN PORT FUNCTION

J1-02 PTE10 GPIO J1-01 PTA2 LPUART0_RX

J1-04 PTE11 GPIO J1-03 PTA3 LPUART0_TX

J1-06 PTE0 GPIO J1-05 PTA13 FTM1_CH7

J1-08 PTE1 GPIO J1-07 PTA12 FTM1_CH6

J1-10 PTE6 GPIO J1-09 PTD0 FTM0_CH2

J1-12 PTE7 GPIO J1-11 PTD1 FTM0_CH3

J1-14 PTD3 GPIO J1-13 PTD2 FXIO_D4

J1-16 PTD5 GPIO J1-15 PTE9 FTM0_CH7

J2 PIN PORT FUNCTION

J2-01 PTC2 FTM0_CH2

J2-02 PTC3 FTM0_CH3

J2-03 PTB5 LPSPI0_PCS

J2-04 PTB4 LPSPI0_SOUT

J2-05 PTB3 LPSPI0_SIN

J2-06 PTB2 LPSPI0_SCK

J2-07 - GND

J2-08 - AREF

J2-09 PTA1 LPI2C0_SDA

J2-10 PTA0 LPI2C0_SCL
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Jumper Settings

Jumper Configuration Description

J104 1-2

2-3 (Default)

Reset signal to OpenSDA, use to enter into OpenSDA 

Bootloader mode 

Reset signal direct to the MCU, use to reset S32K118.

J107 1-2 (Default)

2-3

S32K118 powered by 12V power source.

S32K118 powered by USB micro connector.

J10 2-3 (Default)

1-2

MCU voltage 5v

MCU voltage 3.3v

J108 1-2 (Default) Select LIN master option

J15 1-2 (Default) Used for current measurement

Resistance

R754

R755

R756

R757

R758

Note: The resistances below 

are populated in RevB
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HMI mapping
Component S32K118

Red LED PTD16 (FTM0 CH1)

Blue LED PTE8 (FTM0 CH6)

Green LED PTD15 (FTM0 CH0)

Potentiometer PTA7 (ADC0_SE3)

SW2 PTD3

SW3 PTD5

OpenSDA UART TX PTB1(LPUART0_TX)

OpenSDA UART RX PTB0(LPUART0_RX)

CAN TX PTE5(CAN0_TX)

CAN RX PTE4 (CAN0_RX)

LIN TX PTC7(LPUART1_TX)

LIN RX PTC6 (LPUART1_RX)

SBC_SCK PTB2 (LPSPI0_SCK)

SBC_MISO PTB3(LPSPI0_SIN)

SBC_MOSI PTB4(LPSPI0_SOUT)

SBC_CS PTB5(LPSPI0_PCS1)
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S32K118 EVB 

OUT OF THE BOX
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Step 1: Power up the Board – EVB Power Supplies

• The S32K118-EVB evaluation board powers from a USB 

or external 12V power supply. By default 12V power is 

enabled with J107 (check slide 5)

• Connect the USB cable to a PC using supplied USB 

cable .

• Connect other end of USB cable (microUSB) to mini-B 

port on S32K118-EVB at J7 

• Allow the PC to automatically configure the USB drivers if 

needed

• Debug is done using OpenSDA through J7
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Step 2: Power up the Board – Is it powered on correctly? 

• When powered through USB, LEDs D2 and D3 should light green

• Once the board is recognized, it should appear as a mass storage 

device in your PC with the name S32K118EVB. 
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Step 3: Power up the Board – Is it powered on correctly? 

• Board is preloaded with a software, in 

which the red, blue and green leds will 

toggle at different rates.
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S32K118 JUMPSTART 

EXPERIENCE 

BASED ON THE 

FREEMASTER TOOL
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Install the FreeMASTER tool

 Download and install the FreeMASTER PC application www.nxp.com/FreeMASTER .

 Open the FreeMASTER application on your PC. You should see Welcome page:

http://www.nxp.com/webapp/sps/download/license.jsp?colCode=FMASTERSW&Parent_nodeId=1084998738637727586131&Parent_pageType=product
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Power up the EVB board

 Powers the S32K118EVB evaluation board from a 

USB. By default, the USB power is enabled by J07

jumper.

 Connect the USB cable to a PC and connect micro

USB connector of the USB cable to micro-B port J7 

on the S32K118EVB.

 Allow the PC to automatically configure the USB 

drivers if needed.

 When EVB is powered from USB, LEDs D2 and D3 

should light green.

 The EVB board is preloaded with a software

toggling the RGB LED colors periodically between

RED-GREEN-BLUE.
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Setup serial connection in the FreeMASTER tool

 Setup communication manualy: 

Go to: “Project > Options > Comm“

OR

 Setup communication automatically:

Go to “Tools > Connection Wizard“

Setup communication port to “OpenSDA“ and speed to 115200 b/s:
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The FreeMASTER JumpStart project is loaded



EXTERNAL USE16

The FreeMASTER JumpStart project description 
Pins of the J2 and J1 connectors are configured as outputs. By 

single click on each pin you can change their logical level to log0 

or log1. User can connect e.g. LED diodes to these ouput pins. 

Pins of the J3 and J4 connectors are configured as inputs. 

Logical level (log0/log1) is visualised for all connector pins. 

User can connect e.g. push-button keyboard to these input pins. 

RGB 

LED

Potentiometer

Touch Sense Electrodes

Mechanical 

Buttons

Links to S32K1xx docs:

 Fact Sheet

 Data Sheet

 Reference Manual

 Product Brief

 S32K116EVB Quick Start Guide

Tools:

 FreeMASTER

 S32 Design Studio IDE

 S32K116EVB JumpStart source 

files
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The FreeMASTER JumpStart oscilloscope feature examples

 Display main project panel “View > Project Tree“.

 Display real-time oscilloscope graph examples such as „Potentiometer“ or „Touch Sense Electrodes“.

Analog values from potentiometer. Responses from touch sense electrodes.
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INTRODUCTION TO 

OPENSDA
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Introduction to OpenSDA: 1 of 2

OpenSDA is an open-standard serial and debug adapter. It bridges serial and debug communications between a USB host and an 

embedded target processor. OpenSDA software includes a flash-resident USB mass-storage device (MSD) bootloader and a 

collection of OpenSDA Applications. S32K118 EVB comes with the MSD Flash Programmer OpenSDA Application preinstalled. 

Follow these instructions to run the OpenSDA Bootloader and update or change the installed OpenSDA Application.

IMPORTANT NOTE:  Follow the “Load an OpenSDA 

Application” instructions to update the MSD Flash 

Programmer on your S32K118 EVB  to the latest 

version. 

Enter OpenSDA Bootloader Mode

1. Unplug the USB cable if attached

2. Set J104 on position 1-2.

3. Press and hold the Reset button (SW5)

4. Plug in a USB cable (not included) between a 

USB host and the OpenSDA USB connector 

(labeled “SDA”)

5. Release the Reset button

A removable drive should now be visible in the host 

file system with a volume label of BOOTLOADER. 

You are now in OpenSDA Bootloader mode.

Load an OpenSDA Application

1. While in OpenSDA Bootloader mode, double-click 

SDA_INFO.HTML in the BOOTLOADER drive. A web 

browser will open the OpenSDA homepage containing the 

name and version of the installed Application. This 

information can also be read as text directly from 

SDA_INFO.HTML

2. Locate the OpenSDA Applications 

3. Copy & paste or drag & drop the MSD Flash Programmer 

Application to the BOOTLOADER drive 

4. Unplug the USB cable and plug it in again. The new 

OpenSDA Application should now be running and a 

S32K118 EVB drive should be visible in the host file system

You are now running the latest version of the MSD Flash 

Programmer. Use this same procedure to load other OpenSDA 

Applications.
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Introduction to OpenSDA: 2 of 2

The MSD Flash Programmer is a composite USB application that provides a virtual serial port and an easy and convenient way to

program applications into the S32K118 MCU. It emulates a FAT file system, appearing as a removable drive in the host file system with 

a volume label of S32K118EVB. Raw binary and Motorola S-record files that are copied to the drive are programmed directly into the 

flash of the S32K118 and executed automatically. The virtual serial port enumerates as a standard serial port device that can be opened 

with standard serial terminal applications. 

NOTE:  Flash programming with the MSD Flash Programmer is 

currently only supported on Windows operating systems. 

However, the virtual serial port has been successfully tested on 

Windows, Linux and Mac operating systems. 

Using the MSD Flash Programmer 
1. Locate the .srec file of your project , file is under the 

Debug folder of the S32DS project. 

2. Copy & paste or drag & drop one of the .srec files to 

the S32K118EVB drive

The new application should now be running on the 

S32K118 EVB. Starting with v1.03 of the MSD Flash 

Programmer, you can program repeatedly without the 

need to unplug and reattach the USB cable before 

reprogramming. 

Drag one of the .srec code for the S32K118 EVB board 

over USB to reprogram the preloaded code example to 

another example.

Using the Virtual Serial Port
1. Determine the symbolic name assigned to the S32K118EVB 

virtual serial port. In Windows open Device Manager and look 

for the COM port named “PEMicro/Freescale – CDC Serial 

Port”.

2. Open the serial terminal emulation program of your choice. 

Examples for Windows include Tera Term, PuTTY, and 

HyperTerminal

3. Press and release the Reset button (SW5) at anytime to 

restart the example application. Resetting the embedded 

application will not affect the connection of the virtual serial 

port to the terminal program.

4. It is possible to debug and communicate with the serial port 

at the same time, no need to stop the debug.

NOTE:   Refer to the OpenSDA User’s Guide for a description of a known 

Windows issue when disconnecting a virtual serial port while the COM 

port is in use. 

http://logmett.com/index.php?/download/tera-term-475-freeware.html
http://www.chiark.greenend.org.uk/%7Esgtatham/putty/download.html
http://www.hilgraeve.com/hyperterminal/
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INSTALLING S32DS
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Download S32DS 

Download S32DS from:

S32DS for ARM

https://www.nxp.com/support/developer-resources/run-time-software/s32-design-studio-ide/s32-design-studio-ide-for-arm-based-mcus:S32DS-ARM?tab=Design_Tools_Tab


EXTERNAL USE23

CREATE A NEW 

PROJECT IN S32 

DESIGN STUDIO
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Create New Project: First Time – Select a Workspace

• Start program: Click on “S32 Design Studio for ARM v2.0” icon 

• Select workspace:  

− Choose default (see below example) or specify new one

− Suggestion: Uncheck the box “Use this as the default and do not ask again”

− Click OK
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Create New Project: Top Menu Selection 

• File – New –Project
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Create New Project: S32DS Project

• Project Name:  

−Example: FirstProject

• Project Type: 

−Select from inside 

executable or library folder

• Next
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Create New Project: S32DS Project

• Select Debugger Support and Library Support

• Click Finish
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OpenSDA Configuration

• To Debug your project with OpenSDA, it is necessary to select the OpenSDA in the 

Debug Configuration.

• Select your project, and click on debug configuration
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OpenSDA Configuration

• Select the Debug configuration under GDB PEMicro Interface Debugging

• Click on Debugger tab
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OpenSDA Configuration

• Select OpenSDA as the interface, if your board is plugged should appear in the 

Port field.

• Click Apply and debug to finish.
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DEBUG BASICS
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Debug Basics: Starting the Debugger

• Debug configuration is only required once. Subsequent starting of debugger does 

not require those steps.

• Three options to start debugger:

− If the “Debug Configuration” has not been closed, click on “Debug” button on bottom right

−Select Run – Debug (or hit F11)

Note: This method currently selects the desktop target (project.elf) and gives an error. Do 

not use until this is changed.

−Recommended Method: Click on pull down arrow for bug icon and select …_debug.elf

target
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Debug Basics: Step, Run, Suspend, Resume

• Step Into (F5)

• Step Over (F6)

• Step Return (F7)

• Run

• Suspend 

• Resume (F8)
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Debug Basics: View & Alter Variables

• View variables in “Variables” tab.  

• Click on a value to allow typing in a different value.
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Debug Basics: View & Alter Registers

• View CPU registers in the “Registers” tab

• Click on a value to allow typing in a different value

• View peripheral registers in the EmbSys Registers tab
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Debug Basics: View & Alter Memory  

• Add Memory Monitor

• Select Base Address 

to Start at : 0x20000000

• View Memory
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Debug Basics: Breakpoints

Add Breakpoint: Point and Click

• light blue dot represents debugger breakpoint
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Debug Basics: Reset & Terminate Debug Session

• Reset program counter

• Terminate Ctl+F2() 
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CREATE A P&E DEBUG 

CONFIGURATION 

(OPTIONAL)
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New P&E debug configuration

• Click in debug configurations
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New P&E debug configuration

• Create a new P&E launch configuration

Click to create a new 

P&E launch

Click on the debugger tab.
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New P&E debug configuration

• Select the device 

• Click Apply and debug your application

Select 

device
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USEFUL LINKS
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Useful Links

• Cookbook application note. This application note contains a

bunch of simple examples of how to use different

peripherals.

• S32K1xx community. Visit this site for request support on

the S32K1xx products, you can also look for threads that

may contain the answer that you are looking for.

https://www.nxp.com/docs/en/application-note/AN5413.pdf
https://community.nxp.com/community/s32/s32k
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